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Minimum System Requirements

Before installing HotDocs, make sure your computer meets the minimum require-
ments necessary for using HotDocs:

Minimum Hardware Requirements

= 1 GHz processor (2 GHz or faster recommended)*
* 1 GB RAM (2 GB, recommended)
= 250 MB hard disk space for installation process, 85 MB thereafter

» 1024 x 768 screen resolution

If you previously set your Windows display options to a font size greater than
100% you may find that some HotDocs dialog boxes do not display properly.
You can check your font size setting in your Control Panel by clicking Appear-
ance and Personalization > Display.

Recommended Software Requirements

We actively test and create fixes for software that meet our recommended software
requirements. As such, we encourage you to use HotDocs with the following soft-

ware:

Operating System
= Windows 7 (32-bit and 64-bit)
= Windows 8.1 (32-bit and 64-bit)
= Windows 10 (32-bit and 64-bit)

Word Processor
= Microsoft Word 2003, 2007, 2010, 2013, 2016
= Corel WordPerfect X3 SP2, X4, X5, X6 or X7 (not X8)

Internet Browser

Microsoft Internet Explorer 9, 10, and 11



Legacy Software Environments

The following list represents software that HotDocs is compatible with, but is no
longer actively tested, nor do we fix issues specific to these versions.

Operating System
= Windows XP
= Windows Vista
» Windows 8 not updated to Windows 8.1

Internet Browser

Microsoft Internet Explorer 8

Platform Specific Software Requirements

To upload templates to HotDocs Server, Documents Services, or Cloud Services,
and to enable Silverlight-based interviews for your HotDocs Server-enabled
templates, the following items are required:

» Microsoft Silverlight 5 SDK
» Microsoft Silverlight 5.1 Runtime

Database Integration Requirements

If you plan to integrate desktop versions of HotDocs with a database, you must use
one of the following databases:

* Microsoft Access

= Microsoft SQL Server

» Oracle 8 and up—It is strongly recommended that you use the Oracle Provider
for OLE DB (OraOLEDB) instead of the Microsoft OLE DB Provider for
Oracle (MSDAORA)

» Any ODBC level 1-compliant database (using the Microsoft OLE DB provider
for ODBC (MSDASQL))

HotDocs may also function with other OLE DB providers, as long as the following con-
ditions are met: 1) The OLE DB provider must accept plain-text command strings, 2)
the OLE DB provider must return rowsets (ADO Recordsets) as the result of
commands—not records and/or streams, and 3) the database must reside in a location
accessible by HotDocs. OLE DB providers that expose data in individual Rows and/or
Fields (but not Rowsets) will not work. Please keep in mind that these are recom-
mended guidelines and meeting these guidelines does not necessarily mean your
provider will work with HotDocs.



Installing HotDocs

Additional Minimum Requirements

If you install HotDocs using the MSI installer instead of the EXE installer, you must
install the following software items manually:

= Visual C++ 2010 Redistributable (x86 or x64)

= Visual Studio 2010 Tools for Office Runtime (x86 or x64)
= Microsoft .NET Framework 4.0 Client Profile

» Open XML SDK 2.5

MSXML 6.0 (If using Windows XP SP2 only)

Installing HotDocs
When you insert the HotDocs installation disk in your CD-ROM drive, a CD

browser window should automatically appear. From this window, you can view the
Readme and install HotDocs. Once installation has started, HotDocs prompts you
for all of the information it needs to complete the process.

Before installing HotDocs, make sure your computer meets the minimum require-

ments necessary for using HotDocs (page 5).

To install HotDocs

1. Close all open programs, especially any word processors or existing versions of
HotDocs you may have open.

2. Locate and double-click the setup.exe (for 32-bit operating systems) or
setup64.exe (for 64-bit operating systems) file here. Follow any download
prompts. When HotDocs Setup starts, click Next.

3. Select I accept the terms of the license agreement (page 30); then click Next.

4. On the Installation Type page, choose the type of license (page 10) you want to
use:

+ 30 Day Trial—does not require a license key

+ Licensed—requires a license key

5. Ifyou are using a license, select Licensed, then in the Key text box, type the
license (page 10) HotDocs sent you.

In order for HotDocs to validate the license key, the install needs to access
the HotDocs license server at https://licensing.hotdocs.ws/. If your network
is configured with a proxy server or filter, you may need to ask your network
administrator to add the license server URL to your network’s “white list.” If
this is the case, you also have the option to install the software on a 30-day
trial basis. If you choose the latter option, HotDocs attempts to connect to
the licensing server whenever you start HotDocs, and once your network
administrator enables access to that URL, HotDocs authenticates your instal-
lation. If the problem persists, please contact Support at http://www.hot-
docs.com/support.

6. Best practice is for you to select the Typical install.

Tip: If you want HotDocs to
install in the background,
you can perform a silent
install.

Tip: To install HotDocs from
a CD, select Run from the
Start menu and type
D:\setup. (Substitute the
correct drive letter if your
CD-ROM drive is not
mapped to D:\.)


http://www.hotdocs.com/downloads/software-updates
https://licensing.hotdocs.ws/
http://www.hotdocs.com/support
http://www.hotdocs.com/support
http://wiki.hotdocs.com/index.php?title=Public_Install_Properties#Silent_Install
http://wiki.hotdocs.com/index.php?title=Public_Install_Properties#Silent_Install

+ If you want to change the install location, Browse to the new location.
+ If needed, change the System Language.

7. Click Next.

8. Select the correct version of your word processor. If you have more than one
word processor installed, use the drop-down list to select the one you want
HotDocs to use by default; then click Next.

9. Check that the settings are correct (if not, click Back and change the settings as
needed); then click Install.

10. Comply with any other install instructions; then click Finish.

11. Fill out the HotDocs Product Registration form in your web browser.

If you previously set your Windows display options to a font size greater than
100% you may find that some HotDocs dialog boxes do not display properly.

You can check your font size setting in your Control Panel by clicking Appear-
ance and Personalization > Display.



Starting and Exiting HotDocs

Starting and Exiting HotDocs

Before you edit templates or assemble documents, you must first open the HotDocs
library, which provides the functionality for working with your template files.

To start HotDocs Tip: To start HotDocs, you
= From the Start menu, choose HotDocs > HotDocs Developer. The HotDocs can also click the

. . td HotDocs button in any
library window appears. word processor toolbar. This

will open and display the
To exit HotDocs HotDocs library window.

» From the File menu, click Exit.

Uninstalling HotDocs

You can remove existing versions of HotDocs from your computer by using the
HotDocs uninstall program. When you uninstall, HotDocs removes all program
files from your computer. However, the uninstall feature does not remove any
custom templates, libraries, or answer files you created.

To uninstall HotDocs

1. At the Start menu, open the Control Panel.

2. From the Programs area, find and click the option to remove or Uninstall a
Program.

3. Select the version of HotDocs that needs to be removed, then click Uninstall.

4. Follow the on-screen prompts to remove the application.

If you plan to reinstall HotDocs and you don’t want to retain custom settings
from your prior installation, you must delete the user-specific settings
HotDocs added to the System Registry. For details, see Restoring Installation

Defaults (page 15).
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HotDocs Licensing Overview

With the HotDocs 11.1 release, HotDocs is implementing a new licensing scheme
for desktop HotDocs. When you install HotDocs, you encounter two licensing
options:

» 30 Day Trial (an evaluation license requiring no key)

» Licensed (requires a valid HotDocs license key)

In order for HotDocs to validate the license key, the install needs to access
the HotDocs license server at https://licensing.hotdocs.ws/. If your network
is configured with a proxy server or filter, you may need to ask your network
administrator to add the license server URL to your network’s “white list.” If
this is the case, you also have the option to install the software on a 30-day
trial basis. If you choose the latter option, HotDocs attempts to connect to
the licensing server whenever you start HotDocs, and once your network
administrator enables access to that URL, HotDocs authenticates your instal-
lation. If the problem persists, please contact Support at http://www.hot-
docs.com/support.

Obtaining a License Key

HotDocs provides the following types of license keys:

» A permanent license

= A time limited license (usually for extended evaluations)

To receive a valid license

» Contact HotDocs at 800-828-8328, support@hotdocs.com, or www.hot-
docs.com/support.

Renewing an Expired License

If you have a time limited license, you should ensure that you replace or extend your

license before the term of your license expires; otherwise, your license key becomes
invalid.

To renew an expired license

= Contact HotDocs at 800-828-8328, support@hotdocs.com, or www.hot-

docs.com/support to obtain a new license, or to extend the term of your current
license.

Resolving an Invalid Key Error

There are various scenarios whereby you may receive a license key error.


https://licensing.hotdocs.ws/
http://www.hotdocs.com/support
http://www.hotdocs.com/support
www.hotdocs.com/support
www.hotdocs.com/support
www.hotdocs.com/support
www.hotdocs.com/support

HotDocs Licensing Overview

To resolve licensing errors
= If you receive any other license key error than an expired license, Contact
HotDocs at 800-828-8328, support@hotdocs.com, or www.hotdocs.com/

support.
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HotDocs Installation Overview

When you install HotDocs, two separate installations take place at once: the
HotDocs Setup and the Current User Setup. This two-part installation process enables
multiple users on a single workstation to access HotDocs, using individualized
custom files and settings.

HotDocs Setup

When you first install HotDocs from Sezup.exe (for 32-bit operating systems) or
Setup64.exe (for 64-bit operating systems) (page 7), HotDocs installs the program
files needed to run HotDocs. It also installs the HotDocs Help files and JavaScript
files (which are needed for developing HotDocs Server templates). These files are
installed, by default, to C:\Program Files\HotDocs. This location is not user-specific,
so all users of a single workstation can access to the files.

As HotDocs installs these files, it registers the following information about them in

the Local Machine key of the Windows System Registry:

» The location of the HotDocs executable file
» Which word processors HotDocs supports.

= Preliminary file location information for the various files HotDocs uses, includ-
ing library files and template set files.

HotDocs requires the registry to store all of this information for HotDocs to work
correctly.

Windows System Registry Definition

The Windows System Registry is a central hierarchical database in Windows used
to store information necessary to configure the system for one or more users,
programs, and hardware devices. The Registry contains the following information
that Windows continually references during operation:

= Profiles for each user,

» The programs installed on the computer and the types of documents each can
create

= Property sheet settings for folders and program icons
» What hardware exists on the system
= Which ports are being used.

(Taken from the Microsoft Press Computer Dictionary, Third Edition. Copy-
right © 1998 Microsoft Press.)



HotDocs Installation Overview

Current User Setup

When you install HotDocs, the installation creates a folder named Source in the
HotDocs program folder. This folder contains several files including:

» Word processor macro or startup files
» The user spell-checking dictionary
» The HotDocs tutorial files.

In order for HotDocs to access them during normal usage, these files must be in
user-specific folders on the disk. However, because multiple users may use a single
workstation, HotDocs Setup doesn’t install these files. Instead, when a user logs on
to the workstation and runs HotDocs, the Current User Setup copies these files to
the correct locations for that user (page 13).

The Current User Setup also registers information about each user in the Current
User key of the System Registry. This information includes default file locations for
such things as:

» Templates,
= Answer files

= Library files.

As each user specifies preferences for working with HotDocs, these settings are
likewise written to the Current User key. This enables each workstation user to have
his or her own HotDocs settings without other users overriding those settings with
their own preferences.

The Current User setup happens each time a user starts HotDocs. This means that
each time you run HotDocs, HotDocs checks to make sure all of the required files
(such as word processor startup files) are in their proper locations. If HotDocs can’t
find a file, HotDocs replaces it using a copy from the Source folder.

For example, even if you delete the tutorial files that are installed to your default
Templates folder, because of the Current User Setup folder, the very next time you
start HotDocs, HotDocs recopies the files from the Current User Setup folder to
your default Templates folder. If you want to prevent this behavior, you can open

the Source folder, select the Tutorials subfolder, then on your keyboard, press
Delete.

-——Caution-----—------ -
HotDocs recommends you leave the tutorials intact within the Source folder since they
are an important resource in learning how to user HotDocs.

Default File Locations in HotDocs

When you install and use HotDocs, the installation program makes several entries
in the Windows System Registry that indicate to HotDocs where to look for files,
as well as where to suggest you save files. In most situations, HotDocs uses this

information each time you perform a task in HotDocs. For example, each time you
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Tip: If you perform a
custom installation,
HotDocs installs files and
sets registry entries using
the information you specify
during installation.
Whatever settings you
specify during installation
apply for all users of the
workstation.

create a new template, HotDocs suggests a default location for the new template,
based on the information it finds in the System Registry.

The following is a list of these default locations:

File Type

Program Files
XML Schema Files
JavaScript Files
Silverlight Files
Help Files

Spelling Dictionary
Library Files

Template Files

Includes text templates, form tem-
plates, interview templates, and
auto-assemble files

WordPerfect Macro Files
MS Word Startup Files
Template Sets

Text Document Files
Form Document Files
Answer Files

Publish Settings Files

Catalog Files

Default Location

<Program Files>\HotDocs\

<Program Files>\HotDocs\Schemas\
<Program Files>\HotDocs\ServerFiles\scripts
<Program Files>\HotDocs\ServerFiles\bin\
<Program Files>\HotDocs
<Documents>\HotDocs\Spelling
<Documents>\HotDocs\Libraries

<Documents>\HotDocs\Templates

WordPerfect Macro Folder

Microsoft Word Startup Folder

<Public Documents> \HotDocs\Templates
Word Processor Documents Folder
<Documents>
<Documents>\HotDocs\Answers

<My Documents>\HotDocs\Publish

<Public Documents>\HotDocs\Catalogs

<Program Files> refers to a 32 bit machine; if your machine runs a 64 bit OS, program
files is followed by x86: <Program Files (x86)>.

Adjusting the Default HotDocs Options

Once HotDocs finishes installing, you can change most of the locations listed
above.

To adjust the hotdocs options

1. Open HotDocs, then click the [ HotDocs Options button in the library toolbar.

14



HotDocs Installation Overview

2. Either click the File Locations folder or expand the Word Processors folder. See the
HotDocs Help for details.

HotDocs Player Compatibility with Other Desktop HotDocs
Products

If you want to install HotDocs Player on the same system with another HotDocs
Desktop product (User, Developer LE, or Developer), there are some important
things to keep in mind:

» If HotDocs User, Developer LE or Developer is already installed on the com-
puter, then by default, HotDocs installer places the Player binary files at C:\pro-
gram files\hotdocs\player.

* You should ensure that the version of Player you install should be the same or
a more recent release than the version of User, Developer LE or Developer
installed. This insures that both programs can work together and that Player can
handle HotDocs templates you produce using the other Desktop product.

» Once you install Player on a machine with another desktop HotDocs product
(User, Developer LE or Developer) already installed, if you double-click a
HotDocs Library (HDL) shortcut, HotDocs uses Player to open the library.
To open a file within User, Developer LE or Developer, you must open that
program, then click Open Library to navigate to the library file you want to
edit.

--Caution- - —— ————
Any HotDocs options you change in HotDocs Player also apply for any other

desktop product on the same machine.

Restoring Installation Defaults

At times, you may want to restore default settings in HotDocs. You can accomplish
this by clearing the Current User key of the registry.

-——-Caution----—------- -
You must be extremely careful when working in the Windows System Registry. Failure
to follow the instructions below with exactness could result in your making changes
that negatively affect all programs on your computer. You may want to ask your
system administrator for help if you are unsure of what you are doing.

To restore default settings

1. From the Start menu, select Run. The Run dialog box appears.

2. In the Open text box, type regedit and click Yes. The Registry Editor appears.
3. Navigate to HKEY_CURRENT_USER > Software > HotDocs > HotDocs.
4

Select the HotDocs subfolder and press Delete. Click Yes to confirm the dele-

tion.
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5. Check for the registry key HKEY_CURENT_USER > Software > LexisNexis
> HotDocs. If this location exists, proceed to Step 6. Otherwise, proceed to
Step 7.

6. Select the HotDocs 6 subfolder and press Delete. Click Yes to confirm the dele-

tion.

7. Close the Registry Editor. When you restart HotDocs, HotDocs resets the
registry to the default settings.



Compatibility of HotDocs 11 Files with Earlier Versions of HotDocs

Compatibility of HotDocs 11 Files with Earlier Versions of
HotDocs

This topic describes the compatibility of files between eatlier versions of HotDocs
and the current version of HotDocs:

Installs and Overwrites

When you install the current version of HotDocs over eatlier versions of HotDocs
(starting with HotDocs 06), it overwrites the previous installation.

Library Files

HotDocs contains both template and answer libraries where you can organize your
approach to templates and answer files respectively.

Template Libraries

HotDocs 2008 and earlier saved template libraries in binary format. Starting with
the release of HotDocs 2009, however, you can save template libraries in either
binary format or as XML (page 20). When you open an existing template library in
HotDocs, HotDocs keeps the template library in binary format until you either
manually convert the file to XML format, or you attempt to use foreign characters
(characters that are not compatible with your system’s default language) in the prop-
erties of the library. When you do this, HotDocs prompts you to save the file as
XML.

To manually save the file in either format:
= From the File menu, choose Save Library As and then choose the option you want
from the Save as type drop-down list

Answer Libraries

HotDocs 6 through HotDocs 2008 supported binary answer libraries (or answer
libraries with the .HAL file name extension). Starting with the release of HotDocs
2009, however, HotDocs now supports both binary answer libraries and XML-
based answer libraries (which use the .HDL file name extension). HotDocs
continues to use binary answer libraries as long as the answer file properties of items
in the library use characters compatible with your computer’s default language. If
you define answer file properties that contain foreign characters, HotDocs creates
an XML-based answer library (so that it can properly display these characters in the
Properties tab of the library window.)

17
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-—-Cauwtion----- - - - - - - - -\-\ -\ -\ -\~ -\~ ——————
If you are working in HotDocs 11, but you need your library to be compatible with
HotDocs 2005-2008, do not use any foreign characters (characters that are not com-
patible with your system's default language) in the library properties. Any foreign
characters you use are replaced with boxes or question marks in the HotDocs 2005-
2008 file format.

Templates and Component Files

When you upgrade from earlier versions of HotDocs (starting with HotDocs 6),
HotDocs prompts you to_convert your component files to the format of the current
HotDocs release. When you encounter this prompt, if the file is in the HotDocs
2009 or HotDocs 10 format, you can choose to convert the file either to the current,
HotDocs 11 format, or to keep it in the format in which it was last edited. For
example, if you are upgrading from HotDocs 2009, you can choose to convert the
file to HotDocs 11, or you can choose to keep it in HotDocs 2009 format.

In order to open HotDocs files from a version earlier than 2009, you must convert the
file to the HotDocs 11 format.

Once you convert a component file to HotDocs 11format, you can make it back-
wards-compatible with HotDocs 2009 and HotDocs 10 by specifying a specific
format at the Component File Properties dialog box of Component Manager.

With the release of HotDocs 11.1, HotDocs no longer supports converting component
files to pre-2009/10 formats.

If you need to keep several templates in their existing pre-HotDocs 11 format and
you don't want to be prompted to make this selection on a template-by-template
basis, you can use Template Manager to change the component file format for
several files at once. See Modify Component File Properties Across Multiple Files
for details.

-——-Caution------------
If you are using HotDocs 11 to automate templates for use with an earlier version of
HotDocs, do not use any new features that aren’t supported in the earlier version or

your templates may not work correctly.

Answer Files

HotDocs 6 through HotDocs 2008 releases supported two types of answer files—
binary answer files (ANS) and XML answer files (ANX). Starting with HotDocs
2009, HotDocs saves answer files in XML format only. This means that if you open
a binary answer file (an .ANS file) in HotDocs 11.x, change one or more answers,
and then click Save, HotDocs saves the answer file as XML. However, the file exten-


http://help.hotdocs.com/developer/webhelp/index.htm#Managing_Components_and_Templates_2/mcat2_window_reference_convert_files_dialog_box.htm
http://help.hotdocs.com/developer/webhelp/index.htm#Assembling_Documents_5/ad5_overview_save_answers.htm
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sion does not change; instead, it continues to display as .ANS even though the
contents are XML.

If you are using HotDocs 11 to create answer files for use with earlier versions of
HotDocs, you must save the answer file in a backwards-compatible format. Specif-
ically, if you need to use the answer file with HotDocs 2005 through HotDocs
2008, you must save the file as a HotDocs 2005-2008 answer file. You can select
this format at the New Answer File dialog box or the Save Answer File As dialog box.
You can also select it at the Item Properties dialog box for the answer file. Any unsup-
ported foreign characters you use appear may as boxes or question marks in
HotDocs 2005-2008.

You can use HotDocs 11 answer files with HotDocs 2008 SR2 or higher without making
the files backwards compatible.

-—--Cauwtion------- - - - - - - - - -\ -\ -\ -\ -\ -\ -\-\-\-\-\-+ -+ -+ +—_—_————————— -
When you convert a template created in an earlier version of HotDocs, you should
check for to see if it contains any variable names written in all uppercase letters (ex:
CLIENT NAME), since HotDocs can interpret these as expressions or instructions,
causing an error. For more information on naming variables see Tips on Naming Your
Variables.

HotDocs in Microsoft Word 2007, 2010, and 2013

If you are using HotDocs with Microsoft Word 2007, 2010, or 2013, you should
be aware of a few differences with how HotDocs works in Microsoft Word 2007
and later as opposed to earlier versions of Word:

» Location of HotDocs toolbar: To access the HotDocs editing and navigation
toolbar buttons, you must click the HotDocs tab of the Word ribbon. This
displays each of the editing and navigation commands.

» Accessing the HotDocs button: The HotDocs button is located on the
HotDocs tab of the Word ribbon.

» File formats: Word 2007/2010/2013 includes two new XML-based template
formats—.DOTX (indicates the file does not use macros) and .DOTM (indi-
cates the file does use macros). These template formats are not supported in
HotDocs. However, if you are using Word 2007/2010/2013 to save assembled
documents, you can save in these formats: .DOCX and .DOCM.
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» Compatibility Mode: When you edit existing templates in Word 2007/2010/
2013, the template opens in Compatibility Mode. According to the Microsoft
Word 2010 Help file, “Compatibility Mode makes sure that no new or
enhanced features in Word 2010 are available while you work with a document,
so that people who are using previous versions of Word will have full editing
capabilities.” If you plan to use your templates with just Word 2007/2010/
2013, you can convert your templates to Word 2007-13 format using the Word
conversion tool. (See the Word Help file for additional information on doing
this.) If you plan to distribute or share your templates with users who are using
earlier versions of Word, however, you should either continue to work in Com-
patibility Mode, or you should take care not to use features specific to Word
2007/2010/2013. (The Word Help file has a full list of Word 2007/2010/2013
elements.)

» Styles: When you create a new, empty Word template, HotDocs applies
whatever styles are in HotDocs.dotx to the new template. When you create a
new template based on another template or document, HotDocs applies the
styles used in that template or document to the new template.

HotDocs and XML File Formats

In versions of HotDocs prior to HotDocs 2009, HotDocs saved HotDocs-specific
files such as library files, component files, and so forth in binary formats.

Binary file formats are common in most software applications. They enable infor-
mation about the files to be encoded for storage and processing purposes; however,
in the case of HotDocs, they have the following disadvantages:

» Storing information in a binary format limits third-party application develop-
ers” ability to inspect, edit, or otherwise make use of information contained in
these files

» The binary formats used in HotDocs do not support the use of foreign charac-
ters, or international characters that are not represented in your computer
system's default language

Previous versions of HotDocs supported saving library and answer files both in
binary format, and XML format. While HotDocs can still read and write (save)
library files in both XML and binary formats, from HotDocs 2009 onwards,
HotDocs can only read (but not write) answer files in binary format. HotDocs now
saves all answer files in XML format only. HotDocs made this change as part of its
support of Unicode, because Unicode answers cannot be saved in binary format. See
Compatibility of HotDocs 11 Files with Earlier Versions of HotDocs (page 17) for

details on using backwards-compatible HotDocs 11 answer files.
HotDocs’” move to saving files in the XML format provides the following benefits:

» XML format lends the ability to more easily recover files that become corrupted
or unusable (using the XML schema documents, you, or someone with XML
programming experience, can investigate how to reconstruct the contents,
where this is still possible)
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» XML format enables third-party developers to integrate HotDocs with other
applications

» XML format enables support of a wide range of left-to-right-reading interna-
tional characters

HotDocs uses XML schema documents (or XSD files) to validate XML content. By
default, these documents are located at C:\Program Files\HotDocs\Schemas.

-—-Cution--——-—— -
If you generate XML files using a program other than HotDocs, you must ensure the
encoding declaration in the XML file matches the actual encoding used in the docu-
ment.

XML Explained

In HotDocs, template libraries, answer libraries, answer files, and component files
are all created using XML. This format enables easier integration between HotDocs
and other third-party applications. It also enables you to use a wider range of inter-
national languages (as long as they read left to right) both as you develop templates
and as you assemble documents.

XML (eXtensible Markup Language) is a computer language designed to store and
transmit data between applications. Like HTML (HyperText Markup Language),
it contains customized markers, or tags, that identify the information in an XML
file. However, while HTML describes the way a page looks, XML defines what the
content is and controls the way data is structured, making it easy for diverse
programs to access the same information.

For example, in HTML, to indicate a book title, you would italicize it using the <i>
tag. In XML, you could mark the title using a <booktitle> tag. The HTML tag
simply formats the text (making it italic), while the XML tag actually defines what
the text is (a book title).

All XML code must be validated to ensure proper use of tags and the correct
exchange of data with the application accessing the XML (in this case, HotDocs).
This validation happens using either a document type definition file (or DTD) or
an XML schema document (or XSD file). HotDocs files use the latter method for
validating XML content. By default, these schema documents are found in
C:\Program Files\HotDocs\Schemas.

Several resources are available on the Internet and in print that contain extensive
information on XML, including the official documentation of the World Wide
Web Consortium, which is a non-profit organization responsible for setting
Internet standards. The W3C provides a useful index that references XML tech-
nology.

-——-Caution----—-------
Only people who have a solid understanding of XML should attempt to manually modify
the contents of an XML file.
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International Characters in HotDocs

Unicode is a computer specification that makes it possible for computers to repre-
sent and manipulate characters used in most of the world’s written languages.

According to the technical description given by the Unicode Consortium:

Unicode provides a consistent way of encoding multilingual plain text and
brings order to a chaotic state of affairs that has made it difficult to exchange
text files internationally. Computer users who deal with multilingual text—
business people, linguists, researchers, scientists, and others—will find that the
Unicode Standard greatly simplifies their work. Mathematicians and techni-
cians, who regularly use mathematical symbols and other technical characters,
will also find the Unicode Standard valuable. !

This help file defines Unicode characters that are not part of your typical language set
as foreign or international characters.

HotDocs and Unicode

Unicode support in HotDocs makes it possible to automate and assemble docu-
ments in non-native, left-to-right-reading languages. This includes automating and
assembling Microsoft Word templates as well as PDF-based form templates.

-——Caution-----------
WordPerfect does not support Unicode; therefore, Unicode characters you add to tem-
plates do not display properly when HotDocs assembles them into WordPerfect docu-
ments.

For example, say you need to automate a template using the German language. You
can draft the underlying template text in German, and then create all of the compo-
nents in the template using German (if you want). This may include assigning
component names, titles, prompts, resources, and so forth in that language. Users
can then complete the interview by typing their answers in German. The resulting
assembled document appears entirely in German.

While HotDocs supports using Unicode to produce templates, interviews, and assem-
bled documents in most languages supported by Unicode, the HotDocs application
itself continues to be an English only application.

Concerns with Unicode Character Fonts

Even though HotDocs supports Unicode characters, these characters may not
display properly if you or users do not have fonts installed that can display them.
Some scenarios that may cause this problem follow:

I'"The Unicode Standard: A Technical Introduction. 17 Sept, 2008, 12:27 PM. 5 Dec
2008 http://www.unicode.org/standard/principles.html.
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» Say you automate a template using the Tahoma font on Windows 8. If someone
loads that template on an earlier operating system such as Windows Vista, some
of the characters you used in the template may not display properly because
those characters may not be supported in the version of Tahoma available on
that earlier operating system.

» If you use a very specialized font for displaying symbolic characters in your tem-
plate, if your users do not have the same font installed on their computers, your
text appears as unrecognized characters—usually boxes or question marks.

You should also be careful when assigning font styles (such as bold or italic) to inter-
national characters, as these characters may not display correctly when you apply

these styles.

Foreign Language Number and Date Formats

The following is a list of formats you can customize for foreign language Number
and Date variable formats:

= Alphabetic cardinal numbers (nine, one thousand nine hundred and ninety)

= Ordinals both in dates and numbers (9th, ninth)

= Month names and abbreviations (June, Jun)

= Weekday names and abbreviations (Sunday, Sun)

» The keyword percent used in a number format

» The keyword minus used in a number format

» A comma, period, or spaces used as a thousands separator

» A comma or period used as a decimal separator
You should be familiar enough with the foreign-language equivalent of these words

and phrases to ensure proper spelling and punctuation.
p proper spelling p
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Working with the Library

If you want to create a new template “from scratch,” or edit an existing template,
y g

you begin in the library.

To use the HotDocs template library

1.
2.

Navigate to the HotDocs library window, open a HotDocs library.

From the library toolbar, you can complete any of the following tasks:
» Create a ] New Template

» [/ Edit an existing template or clause library

= Click ¥]Add Item to add a template or other file to the library

» Click #]Remove Item to remove a template or other file from the library
(select the item first)

= 5] Assemble a document

Creating a New Text Template

The first step in automating a HotDocs text template is to create a new template file
that contains your document text.

To create a new text template

1.

8.
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In the HotDocs library window, click the folder where you want to place the
new template.

Click 5] New Template. The New Template dialog box appears.

From the Type drop-down list, select the type of text template you want to
create.

In the File name box, type a file name.

In the Title box, type a title for the template (or accept the suggestion HotDocs
makes). The title is what appears in the library.

Optionally, in the Description box, type a description of your new template.

Select the contents for the new template using one of the following options:

» Empty—creates an empty template file; you can type or copy and paste text
into your template later

» Current open word processor document—copies the contents of the
currently open word processor file into the new template

= Browse—enables you to browse to and then copy the contents of some
other file (for example, a word processor file or another template file) into
the new template

From the New Template dialog box, click OK. HotDocs opens your selected
word processor and displays the new template.


http://help.hotdocs.com/developer/webhelp/index.htm#Using_Libraries/ul_window_reference_hotdocs_library.htm
http://help.hotdocs.com/developer/webhelp/index.htm#Using_Libraries/ul_open_a_library.htm

Inserting a Variable in the Template

Inserting a Variable in the Template

To insert a variable in your template text, you can select a portion of the changeable
text in the template (such as a name, date, number, and so forth) and replace that
text with a variable field.

To replace template text with a variable

1. With the document open in your word processor, select the text you want to
replace and click the «» Variable Field button. The Variable Field dialog box

appears.

2. Select the type of variable you want to insert. Your options include Text,
Number, Date, True/False, Multiple Choice, and Computation.

3. In the Variable box, type a variable name.

4. Optionally, clear Use defaults and from the Format drop-down list, select an
example format.

5. To modify the variable’s properties, click the & Edit Component button.
When finished making changes, click OK. The Variable Field dialog box

appears again.
6. Click either Replace Once or Replace Multiple.

7. Ifyou selected Replace Multiple, the Find and Replace dialog box appears
where you can click the appropriate replacement option: Replace, Replace All,
or Find Next. HotDocs replaces the text.

To insert a variable without replacing text, simply place your cursor where
you want the variable and click the «» Variable Field button. Then follow the
steps outlined above.

Assembling a Document

You assemble a document by selecting a template and then answering the questions
in the interview. When you assemble a document, HotDocs merges your answers
with the unchanging text in the template to produce the final the document. Once
HotDocs assembles the final document, you can view, print, or save the document.
To assemble a document

1. At the HotDocs library window, select a template.

2. Click g Assemble. The Answer File dialog box appears.
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3. Select an answer file, then click OK. The assembly window appears, showing
the interview outline and the first information-gathering dialog.

4. Answer the questions in each dialog, clicking p Next to advance to each new

dialog.

5. After the final dialog, the End of Interview dialog identifies how many ques-
tions remain unanswered. This dialog also provides options for working with
the assembled document.

The Interview Outline Icons

The interview outline to the left of the interview indicates the status of questions in

each dialog:

» O Indicates you have yet to answer any of the questions in the dialog
» & Indicates you have answered at least one of the questions in the dialog
» = Indicates you have answered all questions in the dialog

» & Indicates that the dialog repeats, enabling you to provide more than one set
of answers for that interview element

» @ Indicates you can add a new set of answers to a repeating dialog
» @ Indicates the dialog is required, but still unanswered

» 7 Indicates the dialog is unreachable, as it follows a required but unanswered
dialog



Other Resources for Learning to Use HotDocs

Other Resources for Learning to Use HotDocs

HotDocs Tutorials

Included on the installation CD is a copy of the HotDocs Tutorials, which cover
the basics of template automation and assembly. The lessons are structured such
that you can complete them individually. Alternatively, you can download the
tutorial guide here: http://help.hotdocs.com/desktop.htm.

HotDocs Helps

HotDocs includes a comprehensive help file to help you learn to use the software.
To access this help file, choose @ HotDocs Help from any Help menu within
HotDocs, or open the help file here: http://help.hotdocs.com/desktop.htm.

Other HotDocs Documentation Resources

When visiting the HotDocs help website, you can also:

» Download additional tutorials that cover more advanced features of HotDocs

= Explore the other HotDocs documentation resources such as:
+ HotDocs Resource Center
+ HotDocs Wiki
+ HotDocs Forum
+ HotDocs Software Updates
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Help For Using HotDocs

HotDocs Help Window

HotDocs includes a help file to assist you in using the product.

The HotDocs Help window is divided into three parts—the navigation bar along the top
of the help window, the main help content pane, and the topic navigation path that
appears along the bottom of the window (which is visible as you are viewing specific
help topics). As you view individual help topics, related topics are displayed in the
right-hand navigation bar.

Organization of the Help File

Some contents within the help file are categorized by the type of information avail-

able:

1. Introduction (or Overview): These topics describe, in general terms, a particu-
lar feature or tool of HotDocs.

2. Ata Glance: These topics provide information for a specific dialog box or
window. (You can directly access these help topics by clicking the @ Help
button on the toolbar or the m@1Help button at the top of a dialog box.

Finding Topics in the Help File

To use the help file, you have several options:

» Click the Contents tab in the navigation bar to view the main table of contents
for the help file. You can click a folder and navigate to the specific help topic
that most interests you.

» Click on the Search tab (page 29) and type a search term or phrase in the Search
box and press the ENTER key to view topics that contain your search phrase.
If the search phrase is found, a Search Results page is displayed, showing the dif-
ferent topics, grouped by category, that meet your criteria.

» Click the Index tab to view a listing of topics in the help file, referenced by index
keyword.

» Click the Glossary tab to search for the definition of a specific HotDocs term.
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Forming a Help Search Query

Using Search is perhaps the most powerful option you have for searching the help
file. To form a search query, please keep the following in mind:

» If you want to find a topic that contains two or more terms, regardless of where
the terms appear in the topic, type those terms in the search box. For example,
if you want to find a topic on using the instant update feature for a document,
you could type the search words instant update document. All topics that contain
all of those search terms are listed in the results.

» To search for a specific phrase, you can surround the phrase in quotation marks.
For example, to find information about the Highlight Fields button, type the
search phrase (including quotation marks) “highlight fields button”. All ropics
with that exact phrase are listed on the Search Results page.

* You can also search using capitalized Boolean phrases such as AND, OR, and
NOT:

— Words separated by AND display results that contain all of the words in your
search. (This is the way Search works by default.)

— Words separated by OR display results that contain either of the words in
your search. (For example, you could search using “inzake interview” OR “inter-
view template” and view all topics that contain either of those phrases.

— Words separated by NOT display results that contain the first word in the
search, but not the second. For example, if you want to find all topics that con-

tain the word group but not table, you could type the search phrase group NOT
table.

Other Help Resources

. , o <ff
» Click #e Hide to hide the navigation tabs and 58 Show to show them.
&~
= Click &= Back to return to the previous topic.
» Click = Print to open the Print dialog box and print a copy of the current page.

- Click o Options to view the Options drop-down menu where you can choose
from: Hide, Tabs, Back, Forward, Home, Stop, Refresh, Internet Options,
Print, and Search Highlights Off/On.
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Software License Agreement

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE
INSTALLING THE SOFTWARE. This license agreement (‘License’) is a legal
agreement between you (an individual or a single entity) and the licensor
(‘Licensor’) of this HotDocs software product, which includes computer software,
the associated media (if any), printed materials (if any) and electronic documenta-
tion (together ‘Software’). By opening the packaging for this Software (in the case
of Software supplied on physical media) or by clicking on a button which says ‘1
agree’ or ‘T accept’ (or any comparable action) during installation of the Software,
you will be agreeing to contract with the Licensor on the terms of this License.
Written approval of the terms in this License is not a prerequisite to the validity and
enforceability of this License and no solicitation of any such written approval by or
on behalf of Licensor is to be construed as an inference to the contrary.

IF YOU DO NOT AGREE TO THE TERMS OF THIS LICENSE, WE ARE
UNWILLING TO LICENSE THE SOFTWARE TO YOU AND YOU MUST
DISCONTINUE INSTALLATION OF THE SOFTWARE NOW BY
CLICKING ON THE "I DO NOT ACCEPT" BUTTON BELOW. IN THIS
CASE YOU MUST RETURN THE MEDIA ON WHICH THE SOFTWARE
IS STORED AND ALL ACCOMPANYING DOCUMENTATION TO THE
SUPPLIER, TOGETHER WITH PROOF OF PAYMENT WITHIN 14 DAYS
OF PURCHASE FOR A REFUND.

If you purchased this Software from an authorised reseller, please note that the
reseller has the right to enter into this license on our behalf.

If you reside in the European Union: the Licensor is HotDocs Limited, a limited
company registered in Scotland, UK, with company number SC166375. This
License, its subject matter and its formation (including non-contractual disputes or
claims) is governed by and construed in accordance with English law and any
disputes are subject to the exclusive jurisdiction of the English courts.

If you reside outside the European Union: the Licensor is HotDocs Corporation,
a corporation incorporated in Delaware, USA, with its principal place of business at
387 South 520 West, Suite 210, Lindon, Utah 84042, USA. This License is
governed by and construed under the laws of the State of Utah and the United
States without regard to conflicts of laws provisions thereof. Unless otherwise
elected by the Licensor in writing for the particular instance (which Licensor may
do at its option), the sole jurisdiction and venue for actions related to the subject
matter hereof shall be the Utah state and U.S. federal courts having within their
jurisdiction the location of the Licensor’s principal place of business. Both parties
consent to the jurisdiction of such courts and agree that process may be served in
the manner provided herein for giving of notices or otherwise as allowed by Utah or
federal law.

If you have a written agreement signed by the Licensor which relates to the supply
of the Software and which expressly states that its terms prevail over the terms of any
'click-wrap' or 'shrink-wrap' agreement packaged with the Software, then the
former agreement will prevail over any inconsistent terms of this License. Other-
wise, this License represents the entire agreement between us in relation to the
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licensing of the Software and supersedes any prior agreement, understanding or
arrangement between us, whether oral or in writing.

THIS SOFTWARE REQUIRES A COMPUTER WITH SUFFICIENT
MEMORY AND DISK SPACE, AND A COMPATIBLE OPERATING
SYSTEM. SOME FUNCTIONALITY MAY REQUIRE A SPECIFIC
INTERNET BROWSER OR OTHER SOFTWARE NOT INCLUDED WITH
THIS SOFTWARE.

1. HotDocs License Keys. In this section, a ‘license key’ means a unique alphanu-
meric identifier supplied by the Licensor and required to be entered by the user
during installation of the software. A ‘machine ID’ means an alphanumeric
identifier which is unique to the relevant computer hardware (but which
contains no other data) which merely distinguishes one hardware device from
another. The Licensor reserves the right (but not the obligation) to use license
keys, as further described in this provision, to record installations of some or all
Software and, at the Licensor’s option, restrict the execution of Software to the
duration of the relevant license. Software will (i) attempt to connect over the
Internet to a license key server operated by the Licensor; (ii) upload to the
licensing server the license key and a machine ID for the machine on which the
Software is installed; (iii) store a token on the local machine to record a success-
ful attempt to connect to the licensing server as aforesaid; and, at the Licensor’s
option, (iv) operate only for a short time-limited period in the manner of eval-
uation software until a validated and subsisting license key is successtully veri-
fied. The licensing server is located in the USA. The Licensor will be at liberty
to combine the data uploaded to the licensing server with the Licensor’s records
of customers and sales for the purposes of comparing the installations of
Software with the Licensor’s record of licenses lawfully granted. The license key
is licensed on the same terms as the Software.

2. If Software requires a license key, and until a license key is validated as described
in section 1 of this License, the Software will be deemed to installed for evalua-
tion purpose only. The Licensor hereby grants to you a non-exclusive, non-
transferable license to use the Software on a single computer or workstation for
evaluation purposes only for a maximum period of 30 days.

3. In consideration of you agreeing to abide by the terms of this License and the
payment of the license fee, the Licensor hereby grants to you a non-exclusive,
non-transferable license to use the Software on a single computer or worksta-
tion. You may install the Software on a second computer for use by the same
person. The Software must not be shared or used concurrently on other com-
puters. If any updates, maintenance releases or other modified versions of the
Software are made available to you they will be deemed to be Software supplied
under the terms of this License unless otherwise stated at the time of supply.

4. The Software is licensed for authoring and assembling templates under the
direct control of the licensed user. This License does not permit use of the
Software as part of an automated document assembly solution (for example,
where document assemblies are instigated in bulk or through a database-driven
solution).
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6.

You may make one copy of the Software for back-up purposes only. You may
not transfer your rights to the back-up copy unless you also transfer your rights
to the Software.

Except as expressly set out in this License or as permitted by any local law, you

must not (and must not allow a third party to):

7.

10.

11.

12.

6.1. copy the Software except where such copying is incidental to normal use of
the Software or where it is necessary for the purpose of back-up or operational
security;

6.2. rent, lease, sub-license, loan, translate, merge, adapt, vary or modify the
Software;

6.3. make alterations to, or modifications of, the whole or any part of the Soft-
ware;

6.4. disassemble, de-compile, reverse engineer or create derivative works based
on the whole or any part of the Software.

You acknowledge that all intellectual property rights in the Software through-
out the world belong to HotDocs Limited, that rights in the Software are
licensed (not sold) to you, and that you have no rights in, or to, the Software
other than the right to use it in accordance with the terms of this License.

The Licensor warrants that the media (if any) on which the Software is stored
and distributed are (at the time of supply), and will be for the period of 90 days
after that time (Warranty Period), free from defects in design, material and
workmanship under normal use. If a defect in the media occurs during the
Warranty Period, the Licensor will replace it free of charge if you return it to
the Licensor with proof of purchase and (so far as you are able) a documented
example of such defect or error.

You acknowledge that the Software has not been developed to meet your indi-
vidual requirements. It is your responsibility to ensure that the facilities and
functions of the Software meet your requirements.

You acknowledge that the Software may not be free of bugs or errors and you
agree that the existence of any minor errors does not constitute a breach of this
License.

If, within the Warranty Period, you notify the Licensor in writing of any defect
in the Software in consequence of which it fails to perform substantially in
accordance with the electronic documentation, and such defect does not result
from you having amended the Software or used it in contravention of the terms
of this License, the Licensor shall, at its sole option, (i) repair or replace the
Software or (ii) accept a return of the Software (with proof of purchase) and
provide a refund of the purchase price, provided that you make available all
information that may be necessary to assist the Licensor in resolving the defect,
including sufficient information to enable the Licensor to recreate the defect.

Nothing in this License limits or excludes the liability of either party for death
or personal injury resulting from negligence, fraud, fraudulent misrepresenta-
tion, or for liability which cannot lawfully be excluded or limited.
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13. Subject to section 12:

13.1. the Licensor will not be liable for any loss of profit, loss of business, loss of
goodwill, loss of savings, loss of data, loss of anticipated savings, whether
direct or indirect in each case, or for any indirect loss or consequential loss
whatsoever and howsoever caused (even if caused by the Licensor’s negligence
and/or breach of contract and even if the Licensor was advised that such loss
would probably result);

13.2. the Licensor's maximum aggregate liability under or in connection with
this License, or any collateral contract, whether in contract, tort (including
negligence) or otherwise, is limited to a sum equal to the actual price you paid
for the Software.

14. This License does not provide for maintenance or support for the Software,
which must be purchased separately if required. Licensor has no obligation to
provide maintenance, support or updates, modifications or new releases under
this License.

15. This License sets out the full extent of the Licensor's obligations and liabilities
in respect of the Software. There are no conditions, warranties, representations
or other terms, express or implied, that are binding on the Licensor except as
specifically stated in this License. Any condition, warranty, representation or
other term concerning the Software which might otherwise be implied into, or
incorporated in, this License, or any collateral contract, whether by statute,
common law or otherwise, is hereby excluded to the fullest extent permitted by
law.

16. You must not transfer, assign, charge or otherwise dispose of this License, or any
of your rights or obligations arising under it, without our prior written consent.

17. Upon request from time to time, you agree to certify to the Licensor the number
of copies of the Software installed on your computers.
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Contacting HotDocs

Customer Service

Experienced HotDocs consultants are available to help you with a variety of services,
including integrating HotDocs with other products, building a template library, or
providing training. Please contact us using any of the following methods.

North America:

HotDocs Corporation
387 S 520 W, Suite 210
Lindon, Utah 84042

(800) 500-3627 (Sales)

(801) 615-2200 (Business)

+44 131 226 3999 (International)
(877) 356-3627 (Fax)

(801) 868-3627 (International Fax)

sales@hotdocs.com

www.hotdocs.com

Outside North America:

HotDocs Limited

14 South Charlotte Street
Edinburgh, EH2 4AX
Scotland

0131 226 3999

+44 131 226 3999 (International)
0131 220 9024 (Fax)

+44 131 220 9024 (International Fax)

Contacting Technical Support

Technical Support specialists are available 24 hours a day, seven days a week to help
you use HotDocs. If you are having difficulty installing or using the software, or if
you encounter an error message, please contact a technical support representative at

(800) 828-8328 (US) or 0843 208 0704(UK).



Providing Documentation Feedback

Providing Documentation Feedback

To improve the quality of the tutorials and the help files, we invite you to make
comments or suggestions. When doing so, please include as much information
about your experience using the documentation as possible. For example, include
which version of the product you are using, as well as whether your suggestion is in
regards to the printed HotDocs Installation Guide and Tutorial or the electronic help
file. If commenting about a specific topic, include that information as well.

Please keep in mind that we cannot respond to technical support or project consulting
issues. We are mainly interested in problems with the documentation itself—such as
erroneous information, grammatical and spelling errors, or suggestions for topics to
include in the next release of the software.

To provide documentation feedback

* E-mail your comments and suggestions to publications@hotdocs.com.
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